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Legal Information 
©  Hangzhou Hikrobot Co., Ltd. All rights reserved. 

About this Document 

The Document includes instructions for using and managing the Product. Pictures, 
charts, images and all other information hereinafter are for description and explanation 
only. The information contained in the Manual is subject to change, without notice, due to 
firmware updates or other reasons. Please find the latest version of this Manual at the 
Hikrobot website (https://en.hikrobotics.com/). Unless otherwise agreed, Hangzhou 
Hikrobot Co., Ltd. or its affiliates (hereinafter referred to as “Hikrobot”) makes no 
warranties, express or implied. Please use the Document with the guidance and assistance 
of professionals trained in supporting the Product. 

Acknowledgment of Intellectual Property Rights 

● Hikrobot owns the copyrights and/or patents related to the technology embodied in the 
Products described in this Document, which may include licenses obtained from third 
parties. Any part of the Document, including text, pictures, graphics, etc., belongs to 
Hikrobot. No part of this Document may be excerpted, copied, translated, or modified in 
whole or in part by any means without written permission. 

●  and other Hikrobot's trademarks and logos are the properties of 
Hikrobot in various jurisdictions. Other trademarks and logos mentioned are the 
properties of their respective owners. 

LEGAL DISCLAIMER 

TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, THIS MANUAL AND THE 
PRODUCT DESCRIBED, WITH ITS HARDWARE, SOFTWARE AND FIRMWARE, ARE 
PROVIDED "AS IS" AND "WITH ALL FAULTS AND ERRORS". HIKROBOT MAKES NO 
WARRANTIES, EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITATION, 
MERCHANTABILITY, SATISFACTORY QUALITY, OR FITNESS FOR A PARTICULAR 
PURPOSE. THE USE OF THE PRODUCT BY YOU IS AT YOUR OWN RISK. IN NO EVENT WILL 
HIKROBOT BE LIABLE TO YOU FOR ANY SPECIAL, CONSEQUENTIAL, INCIDENTAL, OR 
INDIRECT DAMAGES, INCLUDING, AMONG OTHERS, DAMAGES FOR LOSS OF BUSINESS 
PROFITS, BUSINESS INTERRUPTION, OR LOSS OF DATA, CORRUPTION OF SYSTEMS, OR 
LOSS OF DOCUMENTATION, WHETHER BASED ON BREACH OF CONTRACT, TORT 
(INCLUDING NEGLIGENCE), PRODUCT LIABILITY, OR OTHERWISE, IN CONNECTION WITH 
THE USE OF THE PRODUCT, EVEN IF HIKROBOT HAS BEEN ADVISED OF THE POSSIBILITY 
OF SUCH DAMAGES OR LOSS. 
YOU ACKNOWLEDGE THAT THE NATURE OF INTERNET PROVIDES FOR INHERENT 
SECURITY RISKS, AND HIKROBOT SHALL NOT TAKE ANY RESPONSIBILITIES FOR 
ABNORMAL OPERATION, PRIVACY LEAKAGE OR OTHER DAMAGES RESULTING FROM 
CYBER-ATTACK, HACKER ATTACK, VIRUS INFECTION, OR OTHER INTERNET SECURITY 
RISKS; HOWEVER, HIKROBOT WILL PROVIDE TIMELY TECHNICAL SUPPORT IF REQUIRED. 
YOU AGREE TO USE THIS PRODUCT IN COMPLIANCE WITH ALL APPLICABLE LAWS, AND 

https://en.hikrobotics.com/
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YOU ARE SOLELY RESPONSIBLE FOR ENSURING THAT YOUR USE CONFORMS TO THE 
APPLICABLE LAW. ESPECIALLY, YOU ARE RESPONSIBLE, FOR USING THIS PRODUCT IN A 
MANNER THAT DOES NOT INFRINGE ON THE RIGHTS OF THIRD PARTIES, INCLUDING 
WITHOUT LIMITATION, RIGHTS OF PUBLICITY, INTELLECTUAL PROPERTY RIGHTS, OR 
DATA PROTECTION AND OTHER PRIVACY RIGHTS. YOU SHALL NOT USE THIS PRODUCT 
FOR ANY PROHIBITED END-USES, INCLUDING THE DEVELOPMENT OR PRODUCTION OF 
WEAPONS OF MASS DESTRUCTION, THE DEVELOPMENT OR PRODUCTION OF 
CHEMICAL OR BIOLOGICAL WEAPONS, ANY ACTIVITIES IN THE CONTEXT RELATED TO 
ANY NUCLEAR EXPLOSIVE OR UNSAFE NUCLEAR FUEL-CYCLE, OR IN SUPPORT OF 
HUMAN RIGHTS ABUSES. 
THE PERFORMANCE DATA IN THIS PUBLICATION IS BASED ON HIKROBOT'S INTERNAL 
RESEARCH/EVALUATION. ACTUAL DATA MAY VARY DEPENDING ON SPECIFIC 
CONFIGURATIONS AND OPERATING CONDITIONS AND HIKROBOT SHALL NOT BEAR THE 
CONSEQUENCES ARISING THEREFROM. 
IN THE EVENT OF ANY CONFLICTS BETWEEN THIS MANUAL AND THE APPLICABLE LAW, 
THE LATTER PREVAILS. 
 

Regulatory Information 

Note 
These clauses apply only to the products bearing the corresponding mark or information. 

EU Conformity Statement 

 

This product and - if applicable - the supplied accessories too are 
marked with "CE" and comply therefore with the applicable 
harmonized European standards listed under the Directive 
2014/30/EU(EMCD),Directive 2001/95/EC(GPSD) and Directive 
2011/65/EU(RoHS). 

 

2012/19/EU (WEEE directive): Products marked with this symbol 
cannot be disposed of as unsorted municipal waste in the European 
Union. For proper recycling, return this product to your local supplier 
upon the purchase of equivalent new equipment, or dispose of it at 
designated collection points. For more information see: 
http://www.recyclethis.info 

 

Regulation (EU) 2023/1542(Battery Regulation): This product contains 
a battery and it is in conformity with the Regulation (EU) 2023/1542. 
The battery cannot be disposed of as unsorted municipal waste in the 
European Union. See the product documentation for specific battery 
information. The battery is marked with this symbol, which may 
include lettering to indicate cadmium (Cd), or lead (Pb). For proper 
recycling, return the battery to your supplier or to a designated 
collection point. For more information see: www.recyclethis.info. 
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KC Mark Certification 

Class A: The device is advised to note that as a seller or a business user (Class A) Devices 
and intended for use outside the Home area. 

A급 기기: 이 기기는 업무용(A급) 전자파적합기기로써 판매자 또는 사용자는 이 점을 

주의하시기바라며, 가정 외의 지역에서 사용하는 것을 목적으로 합니다. 

Symbol Conventions 
The symbols that may be found in this document are defined as follows. 
 

Symbol Description 

Danger 
Indicates a hazardous situation which, if not avoided, will or 
could result in death or serious injury. 

Caution 
Indicates a potentially hazardous situation which, if not avoided, 
could result in equipment damage, data loss, performance 
degradation, or unexpected results. 

Note 
Provides additional information to emphasize or supplement 
important points of the main text. 

  

Available Model 
This manual is applicable to the ID2000 Series, ID3000 Series, ID5000 Series, and IDH 
Series Smart Code Reader. 

Contact Information 
Hangzhou Hikrobot Co., Ltd. 
E-mail: global.support@hikrobotics.com 
Website: https://en.hikrobotics.com/ 

 

mailto:global.support@hikrobotics.com
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Chapter 1 Ethernet/IP 

1.1 Introduction 

Ethernet/IP is a network suitable for industrial environment and time-critical applications. 
Ethernet/IP uses standard EtherNet, TCP/IP technology and CIP's open application layer 
protocol, and it can share the network with normal EtherNet communication. 

Note 

This chapter takes Omron NX series PLC as an example to explain how to communicate 
with the smart code reader via the Ethernet/IP communication protocol. For other devices, 
refer to the user manual provided by the manufacturer and make related settings by reading 
contents of this chapter. 
 

1.2 Hardware Wiring 

The wiring of Omron NX series PLC and the smart code reader is shown below. 

Omron NX Series PLC Industrial Switch

Smart Code Reader

 

Figure 1-1 Hardware Wiring 

1.3 Smart Code Reader Settings 

Before using the smart code reader’s Ethernet/IP function to communicate with PLC devices, 
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you need to set the smart code reader first via the IDMVS client software. 
Before you start: 
● Make sure that the PC has installed the IDMVS client software with version of V3.0.0 and 

above. 
● Check the device’s firmware version. Please refer to the relevant instructions in the 

industrial protocol for specific requirements. 

Steps  

1. Double-click the device in the device list to connect it to the client software. 
2. Set the device mode as Normal or Work Mode in the live view window. 
3. Go to IO Control in the panel. 
4. Select On for trigger mode and select trigger source according to actual situation. 
● When using industrial protocol to trigger the device, select Software as the trigger source 

and click Enable Auto-Trigger. 
● When using IO to trigger the device, select Pin* as the trigger source. Pin hardware 

triggering only feeds back the result region (decoding results), other status bits will not 
be returned. 

Note 

When selecting pin hardware triggering as the trigger source, avoid triggering in the 
industrial protocol control region (set camera control bits), otherwise the device will 
automatically switch to soft trigger mode, making subsequent IO signals unable to trigger 
the device. 
 

5. Go to Communication Control, select Ethernet/IP as the communication protocol, and 
enable the Ethernet/IP Enable. 

6. Set Ethernet/IP Input Assembly Size and Ethernet/IP Output Assembly Size according to 
actual demands. 

 

Figure 1-2 Set Parameters 
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Note 

The default value of Ethernet/IP Input Assembly Size and Ethernet/IP Output Assembly 
Size is 200. 
 

7. Go to Data Processing in the left navigation panel, and set format and contents contained 
in the outputted information. 

 

Figure 1-3 Set Data Processing 

Note 

The result output function can also be set by the data processing module after the device 
connects to the IDMVS. For details, please refer to the relevant chapter in the user manual 
of the corresponding model. 
 

1.4 PLC Settings 

This section takes Omron NX series PLC as an example to explain how to set PLC. For the 
PLC from other manufacturers or different models, refer to this section and its user manual 
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to configure. 

1.4.1 Create Sysmac Studio Project 

You need to create Sysmac Studio project first when using Omron NX series PLC. 

Steps  

1. Run Sysmac Studio, click New Project, enter parameters, and click Create. 

 

Figure 1-4 Create New Project 

2. Create a new Global Variables whose size should be the same with that of the smart code 
reader configured in the IDMVS. 

 

Figure 1-5 Create Global Variables 

Note 

When connecting multiple smart code readers, you should create several global variables 
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with different names.  
 

3. Go to Controller Setup → Memory Settings, check Enable of DM, and allocate the global 
variables created in step 2 to DM memory. 

 

Figure 1-6 Enable DM Area Type 

4. Go to Controller Setup → Built-in Ethernet/IP Port Settings, and set the IP address of 
PLC port 1.  

 

Figure 1-7 Set IP Address 

Note 

Make sure that the PLC and the smart code reader’s IP address are in the same network 
segment. 
 

5. Click Tools in the menu, and select Ethernet/IP Connection Settings. 
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Figure 1-8 Open Ethernet/IP Connection Settings 

6. Double click port 1 in Ethernet/IP Device List, and click Registration All in tag sets to 
register global variables. 

 

Figure 1-9 Ethernet/IP Device List 

 

Figure 1-10 Register Global Variables 

7. Right click in the Target Device area, click Display EDS Library, select the corresponding 
EDS file in the EDS library, and click Install.  
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Figure 1-11 Install EDS File 

8. Click  in the Target Device area to add devices, enter Node address, Model name, and 
Revision according to actual demands, and click Add. 

9. Click  in Built-in Ethernet/IP Port Settings, add created target devices, select 

Consume Data From/Produce Data To as Connection I/O Type, and set size and originator 
variable that are global variable created before. 

 

Figure 1-12 Create Target Device 

10. Go to Tools → Export Global Variables → Network Configurator…, and export the 
global variables. 
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Figure 1-13 Export Global Variable File 

11. Save and compile the project, and synchronize it to the PLC controller. 

1.4.2 Network Configurator Settings 

After the project is created, you need to set it via the network configurator. 

Steps  

1. Run Network Configurator, click EDS File and select Install…to import the device’s EDS 
file. 

 

Figure 1-14 Import EDS File 

2. Drag in the corresponding PLC controller and the smart code reader. 
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3. Right click the smart code reader to modify its IP address. 

 

Figure 1-15 Modify IP Address 

4. Double click the PLC, go to Tag Sets → To/From File → Import from File, and import 
the global variables created in the Sysmac Studio. 

 

Figure 1-16 Import Global Variables 

5. Establish the connection between the smart code reader’s input/output and the global 
variables of PLC controller. Data In connects to Input_13, and Data Out connects to 
Output_22, and set Packet Interval as 50 ms.  
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Figure 1-17 Establish Connection 

6. Select interface for PLC controller and download configuration to the PLC. 

Note 

After the PLC and the smart code reader is successfully connected, the PLC’s red NET ERR 
indicator will go off. 
 

 

Figure 1-18 Select PLC’s Communication Interface Type 



Smart Code Reader Industrial Protocol Operation Manual 

11 

 

Figure 1-19 Connect to the PLC 

 

Figure 1-20 Download Configuration to the PLC 
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1.5 Input and Output Mapping 

1.5.1 Input Mapping 

The definition of input mapping (i.e. smart code reader > PLC controller) is shown below. 

Table 1-1 Input Mapping Table 

Byte BIT7 BIT6 BIT5 BIT4 BIT3 BIT2 BIT1 BIT0 

0-1 useful data length 

2     Decoding Acquiring Trigger  

Ack 

Trigger 
Ready 

3 General 

Fault 

     Results  

NG 

Results 
OK 

4-17 Reserved 

18-19 Result Length 

20 Result Data 0 

… … 

199 Result Data 179 

… Result Data … 

Table 1-2 Input Mapping Table Description 

Name Description 

Trigger Ready The device is ready to receive new trigger signals.  

When the Trigger Enable is set and the device is ready to receive 
the next trigger signal, the Trigger Ready is set. 

Trigger Ack The device has already received the trigger signal. 

Acquiring The device is acquiring images. 

Decoding The device is recognizing decodes on images. 

Reserved Reserved. 

Results OK The device outputs new results successfully. 

When the PLC is set as Results Ack, this bit will be cleared. 
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1.5.2 Output Mapping 

The definition of output mapping (i.e PLC controller > smart code reader) is shown below. 

Table 1-3 Output Mapping Table 

Byte BIT7 BIT6 BIT5 BIT4 BIT3 BIT2 BIT1 BIT0 

0      Results 
Ack 

Trigger  Trigger 
Enable 

1 Clear 

Error 

      Execute 
Command 

2-17 Reserved 

18-19 User Data Length 

20 User Data 0 

… … 

199 User Data 179 

… User Data … 

 
 

Results NG The device does not read codes or get outputted results. 

When the PLC is set Results Ack, it will be cleared. 

Note 

You should disable NoRead function when using NG signal. 

General Fault A device’s internal fault occurred, and you can clear this signal via 
Clear Error. 

Result Length It refers to the length of valid data contained in the result area. 

Result Data It refers to the reading result of the device in ASCII code format 
of continuous storage. 

● When the result data length is less than the configured result 
module, the remaining data is filled with 0. 

● When the result data length is greater than the configured result 
module, the extra data is cut off. 
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Table 1-4 Output Mapping Table Description 

1.6 Trigger Test 

Communication Sequence Diagram 

The communication sequence diagram of PLC and the device is shown below. 

 

Figure 1-21 Communication Sequence Diagram 

Name Description 

Trigger Enable The PLC controls the device’s trigger enable function via this 
bit. 

Trigger When following conditions are met, the PLC sets this bit to 
trigger the device to acquire an image and run the algorithm 
once. 

● Trigger Enable is set. 
● The device is not currently acquiring images and running 

algorithms. 
● Trigger Ready is set. 

Results Ack After the PLC gets the latest results, Result Ack is set. At the 
same time, Results OK and Results NG will be cleared. 

Reserved Reserved. 

Clear Error Clear error status. 
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The logic of the above sequence diagram is shown below: 
1. PLC sets Trigger Enable signal DataOut[0].0. After the device is ready, set Trigger Ready 

signal DataIn[2].0. 
2. After detecting the device’s Trigger Ready signal, the PLC sends Trigger signal 

DataOut[0].1 and controls the device to operate once. 
3. The device starts to acquire images and runs the algorithm after receiving Trigger signal. 
● If codes are read successfully, set the Results OK signal DataIn[3].0 and put code contents 

into the address starting from DataIn [20]. 
● If codes are not read successfully, set the Results NG signal DataIn[3].1 and clear data 

starting from address of DataIn [20]. 

Note 

● If codes are not read successfully when NoRead is enabled, Results OK + “NoRead” 
character are fed back. 

● If codes are not read successfully when NoRead is disabled, Results NG signal is fed back. 
 

4. After detecting Results OK/NG signal, the PLC starts to read results from DataIn [20]. 
5. After reading results is finished, set Results Ack signal DataOut[0].2, and notify the device. 
6. After triggering is finished, reset the PLC first (set Results Ack) and then repeat the steps 

from 1 to 5 above for a new round of triggering. 

Note 

If the smart code reader cannot output results after receiving the Trigger signal due to an 
internal error (for example, acquiring images are not enabled after the smart code reader is 
connected to the IDMVS), the General Fault signal DataIn[3].7 will be set at this time. After 
the PLC confirms the cause of the error, set the Clear Error signal DataOut[1].7, and the 
trigger operation can be continued after the error is cleared. 
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Create Variables 

Create variables in accordance with the device’s input/output mapping area. 

 

Figure 1-22 Create Variables 

Ladder Diagram 

When the PLC continuously triggers the device to read codes, related ladder diagrams are 
shown below. 
● Enable Trigger 

 

Figure 1-23 Enable Trigger 

● Send Trigger Signal 
The trigger signal can be generated by adding an edge signal before Trigger Ready 
according to actual demands. For example, when the PLC detects the photoelectric input 
signal, it sends a trigger signal once. 

 

Figure 1-24 Send Trigger Signal 

● Clear Trigger Signal 

 

Figure 1-25 Clear Trigger Signal 
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● Get Device Results 
When the device feeds back the Results OK or Results NG signal, it means that result data 
has been updated, and the PLC can read result data to the user's storage area. After the 
reading is complete, set the Results Ack signal to acknowledge that the device has 
completed reading result data. If the order of code byte doesn't match the actual order, 
enable the Result Byte Swap in the device configuration. 

 

Figure 1-26 Get Device Results 

Note 

● If the endianness of codes read is different from actual one, you can enable result byte 
swap function via the IDMVS. 

● Result Byte Swap only takes effect for float type data. 
 

● Clear Error 

 

Figure 1-27 Clear Error 

View Results 

Open the variable monitoring window of the Sysmac Studio, and add the created DataIn 
input variable and DataOut output variable. The online value of the variable is the internal 
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input/output value of the device. 

 

Figure 1-28 View Results 
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Chapter 2 Profinet 

2.1 Introduction 

Profinet is an open industrial EtherNet standard launched by PI for automation. Profinet 
uses TCP/IP and IT standards. It is a real-time EtherNet that not only supports standard 
TCP/IP, but also provides time precision that standard EtherNet cannot achieve. 

Note 

This chapter takes Siemens S7 series PLC as an example to explain how to communicate 
with smart code readers via Profinet communication protocol. For other devices, refer to the 
user manual provided by the manufacturer and make related settings by reading contents 
of this chapter. 
 

2.2 Hardware Wiring 

The wiring of Siemens S7 series PLC and the smart code reader is shown below. 

Industrial Switch

Smart Code Reader

Siemens S7 Series PLC

 

Figure 2-1 Hardware Wiring 

Note 

The IP address of the device in the PLC configuration must differ from that of the device in 
the IDMVS, otherwise it may result in communication errors. 
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2.3 Smart Code Reader Settings 

Before using the smart code reader’s Profinet function to communicate with other devices, 
you need to set the smart code reader first via the IDMVS client software. 
 
Before you start: 
● Make sure that the PC has installed the IDMVS client software with version of V3.0.0 or 

later. 
● Check the device’s firmware version. Please refer to the relevant instructions in the 

industrial protocol for specific requirements. 

Steps  

1. Double click the device in the device list to connect it to the client software. 
2. Set the device mode as Normal or Work Mode in the live view window. 
3. Select the connected device, and go to IO Control in the panel. 
4. Select On for trigger mode and select trigger source according to actual situation. 
● When using industrial protocol to trigger the device, select Software as the trigger source 

and click Enable Auto-Trigger. 
● When using IO to trigger the device, select Pin* as the trigger source. Pin hardware 

triggering only feeds back the result region (decoding results), other status bits will not 
be returned. 

Note 

When selecting pin hardware triggering as the trigger source, avoid triggering in the 
industrial protocol control region (set camera control bits), otherwise the device will 
automatically switch to soft trigger mode, making subsequent IO signals unable to trigger 
the device. 
 

5. Go to Communication Control, select Profinet as the communication protocol, and enable 
the Profinet Enable. 

6. Enter Profinet Device Name according to actual demands. 

Note 

Make sure that the device name is unique. 
 

7. Set Profinet Result Module Size and Profinet Result Timeout according to actual 
demands. 

Note 

The default value of Profinet Result Module Size is 64 bytes. 
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Figure 2-2 Set Communication Parameters 

8. Go to Data Processing in the left navigation panel, and set format and contents contained 
in the outputted information. 

Note 

The result output function can also be set by the data processing module after the device 
connects to the IDMVS. For details, please refer to the relevant chapter in the user manual 
of the corresponding model. 
 

2.4 PLC Settings 

This section takes Siemens S7 series PLC as an example to explain how to set PLC. For the 
PLC from other manufacturers or different models, refer to this section and its user manual 
to configure. 

Steps  

1. Run TIA Portal, click Create new project, enter parameters, and click Create. 
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Figure 2-3 Create New Project 

2. Go to Options → Manage general station description files (GSD), import the GSDML files 
to TIA Portal, and click Install. 

 

Figure 2-4 Install GSDs 

3. Go to Devices & networks → Hardware category → Other field devices → PROFINET 

IO → Sensors → Hikvision → Machine Vision Systems, find the corresponding device, 
drag or double-click the device to move it onto the network view. 

4. Add the PLC controller and distribute the device to it. 
5. Double click the device to set its name. 

Note 

The name configured here should be the same with that in the IDMVS. Otherwise, 
communication errors may occur. 
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6. Set the subnet that the interface is networked with, and the IP address. 

Note 

The device’s IP address should be different with that in the IDMVS. Otherwise, 
communication errors may occur. 
 

7. Set the device’s IO cycle and other parameters. 

Note 

Increase the value of Accepted update cycles without IO data in Watchdog time if the 
device goes offline. 
 

8. Recompile and load the PLC program. When the PLC is connected to the device, the status 
indicators of the PLC and device will be solid green. 

2.5 Device Module Definition 

The device has five configurable modules as shown below: 
● Acquisition Status Module 
● Acquisition Control Module 
● Reads Result 64 Bytes Module 
● Reads Result 128 Bytes Module 
● Reads Result 250 Bytes Module 

Acquisition Status Module 

The acquisition status module sends the information about the current status of the device 
from the device to the PLC. 
● Module Slot No.: 1 
● Module Size: 1 byte 
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Table 2-1 Acquisition Status Module Description 

Bit Name Description 

0 Trigger Ready The device is ready to receive new trigger signals.  

When the Trigger Enable is set and the device is ready to receive the 
next trigger signal, the Trigger Ready is set. 

1 Trigger Ack The device has already received the trigger signal. 

2 Acquiring The device is acquiring images. 

3 Decoding The device is recognizing decodes on images. 

4 Results OK The device outputs new results successfully. 

When the PLC is set Results Ack, it will be cleared. 

5 Results NG The device does not read codes or get outputted results. 

When the PLC is set Results Ack, it will be cleared. 

Note 

You should disable NoRead function before using NG signal. 

6 Reserved Reserved. 

7 General Fault An internal error is generated. 

Acquisition Control Module 

The acquisition control module sends images from the PLC to the device. 
● Module Slot No.: 2 
● Module Size: 1 byte 
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Table 2-2 Acquisition Control Module Description 

Bit Name Description 

0 Trigger Enable The PLC controls the device’s trigger enable function via 
this bit. 

1 Trigger When following conditions are met, the PLC sets this bit to 
trigger the device to acquire an image and run the 
algorithm once. 

● Trigger Enable is set. 
● The device is not currently acquiring images and running 

algorithms. 
● Trigger Ready is set. 

2 Results Ack After the PLC gets the latest results, Result Ack is set. At 
the same time, Results OK and Results NG will be cleared. 

3 Execute 
Command 

Execute the command specified in the User Data area. 

4-6 Reserved Reserved. 

7 Clear Error Clear error status. 

Reads Result 64 Bytes Module 

The reads result 64 bytes module reads and sends the device’s processing result from the 
device to the PLC. 
● Module Slot No.: 3, configurable 
● Module Size: 65 bytes 

Table 2-3 Reads Result 64 Bytes Module Description 

Bit Name Description 

0 Result Length It refers to the actual length of data contained in the Result 
Data area. 

1…64 Result Data The result output by the device, and its length is 64 bytes. 
● When the actual result is smaller than 64 bytes, the spare 

bytes will be filled with 0. 
● When the actual result is greater than 64 bytes, the extra 

bytes will be cut off. 

Reads Result 128 Bytes Module 

The reads result 128 bytes module is the result data and is sent to the PLC by the device. 
● Module Slot No.: 3, configurable  
● Module Size: 129 bytes 
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Table 2-4 Reads Result 128 Bytes Module 

Bit Name Description 

0 Result Length It refers to the actual length of data contained in the Result 
Data area. 

1…128 Result Data The result output by the device, and its length is 128 bytes. 
● When the actual result is smaller than 128 bytes, the 

spare bytes will be filled with 0. 
● When the actual result is greater than 128 bytes, the 

extra bytes will be cut off. 

Reads Result 250 Bytes Module 

The reads result 250 bytes module is the result data and is sent to the PLC by the device. 
● Module Slot No.: 3, 5, 6, 7, configurable  
● Module Size: 251 bytes 

Table 2-5 Reads Result 250 Bytes Module 

Bit Name Description 

0 Result Length it refers to the actual length of data contained in the Result 
Data area. 

1…250 Result Data The result output by the device, and its length is 250 bytes. 
● When the actual result is smaller than 250 bytes, the 

spare bytes will be filled with 0. 
● When the actual result is greater than 250 bytes, the 

extra bytes will be cut off. 
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2.6 Trigger Test 

Communication Sequence Diagram 

The communication sequence diagram of PLC and the device is shown below. 

 

Figure 2-5 Communication Sequence Diagram 

The logic of the above sequence diagram is shown below: 
1. PLC sets Trigger Enable signal Q0.0. After the device is ready, set Trigger Ready signal 

I0.0. 
2. After detecting the device’s Trigger Ready signal, the PLC sends Trigger signal Q0.1 and 

controls the device to operate once. 
3. The device starts to acquire images and runs the algorithm after receiving Trigger signal. 
● If codes are read successfully, set the Results OK signal I0.4 and put code contents into 

the address starting from QB2. 
● If codes are not read successfully, set the Results NG signal I0.5 and clear the start 

address of QB2. 

Note 

● If codes are not read successfully when NoRead is enabled, Results OK + “NoRead” 
character are fed back. 

● If codes are not read successfully when NoRead is disabled, Results NG signal is fed back. 
 

4. After detecting Results OK/NG, the PLC starts to read results from QB2. 
5. After reading results is finished, set Results Ack signal Q0.2, and notify the device. 
6. After triggering is finished, reset the PLC first (set Results Ack) and then repeat the above 

steps from 1 to 5 for a new round of triggering. 
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Note 

If the smart code reader cannot output results after receiving the Trigger signal due to an 
internal error (for example, acquiring images are not enabled after the smart code reader is 
connected to the IDMVS), the General Fault signal I0.7 will be set at this time. After the PLC 
confirms the cause of the error, set the Clear Error signal Q0.7, and the trigger operation can 
be continued after the error is cleared. 
 

Create Variables 

Create a new PLC variable according to the address assigned to the device according to the 
device configuration, and you can view the current value of each module of the device online. 

 

Figure 2-6 Create PLC Variable 

 

Figure 2-7 Overview of Address 

Ladder Diagram 

When the PLC triggers the device to read codes, related ladder diagrams are shown below. 
● Enable Trigger 
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Figure 2-8 Enable Camera 

● Send Trigger Signal 
The trigger signal can be generated by adding an edge signal before Trigger Ready 
according to actual demands. For example, when the PLC detects the photoelectric input 
signal, it sends a trigger signal once. The figure below describes that a trigger signal is 
outputted every second via the internal system clock. 

 

Figure 2-9 Send Trigger Signal 

● Clear Trigger Signal 

 

Figure 2-10 Clear Trigger Signal 

● Get Device Results 
Create a DB data block to store the reading result, add the result variable as shown below. 
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The first byte is the result length, and the result data is stored starting from the second byte. 

 

Figure 2-11 Add Result Data Block 

When the device feeds backs the Results OK or NG signal, it means that the result data has 
been updated, and the PLC reads the result data to the DB data block. 
After the reading is finished, set the Results Ack signal to acknowledge that the device has 
finished reading the result data. 

 

Figure 2-12 Get Results 

● Clear Error 
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Figure 2-13 Clear Error 

View Results 

Through the monitoring and option tab, you can monitor the status of the variables of each 
module of the device and view the result output. You can also add trace records of the 
variables via the Trace tab to view the control sequence. 

 

Figure 2-14 View Control Sequence 

 
  



Smart Code Reader Industrial Protocol Operation Manual 

32 

Chapter 3 ModBus 

3.1 Introduction 

Modbus is a request/response protocol whose services are specified by function codes. 
Port 502 is reserved for ModBus communication. It uses standard EtherNet hardware and 
software to exchange I/O data and diagnostic information. 

Note 

This chapter takes Siemens S7 series PLC as an example to explain how to communicate 
with smart code readers via ModBus communication protocol. For other devices, refer to 
the user manual provided by the manufacturer and make related settings by reading 
contents of this chapter. 
 

3.2 Hardware Wiring 

The wiring of PLC controller, ModBus TCP test tool, and the smart code reader is shown 
below. 

PLC Controller

Smart Code Reader

Industrial Switch

ModBus TCP Test Tool

 

Figure 3-1 Hardware Wiring 

3.3 Smart Code Reader Settings 

Before using the smart code reader’s ModBus function to communicate with other devices, 
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you need to set the smart code reader first via the IDMVS client software. 
Before you start: 
● Make sure that the PC has installed the IDMVS client software with version of V3.0.0 and 

above. 
● Check the device’s firmware version. Please refer to the relevant instructions in the 

industrial protocol for specific requirements. 

Steps  

1. Double click the device in the device list to connect it to the client software. 
2. Set the device mode as Normal or Work Mode in the live view window. 
3. Select the connected device and go to IO Control in the panel. 
4. Select On for trigger mode and select trigger source according to actual situation. 
● When using industrial protocol to trigger the device, select Software as the trigger source 

and click Enable Auto-Trigger. 
● When using IO to trigger the device, select Pin* as the trigger source. Pin hardware 

triggering only feeds back the result region (decoding results), other status bits will not 
be returned. 

Note 

When selecting pin hardware triggering as the trigger source, avoid triggering in the 
industrial protocol control region (set camera control bits), otherwise the device will 
automatically switch to soft trigger mode, making subsequent IO signals unable to trigger 
the device. 
 

5. Go to Communication Control, select ModBus as the communication protocol, and enable 
the ModBusp Enable. 

6. Set ModBus Mode as Server or Client. 
● Control, status and result are in holding registers when the ModBus mode is in server, and 

offset address is fixed, and only result module size can be configured. 
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Figure 3-2 Server Mode 

● You should set the server’s (i.e. PLC or ModBus test tool) IP address and port number, 
and control poll interval when selecting client in ModBus Mode. Control, status and result 
modules are in holding registers, and offset address and result module size can be 
configured. 

Note 

The device firmware version V3.2.2 or above supports slave ID. The default slave ID is 255 
or 0. Incorrect parameters may cause connection failure. 
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Figure 3-3 Client Mode 

7. Go to Data Processing in the left navigation panel, and set format and contents contained 
in the output information. 

Note 

The result output function can also be set by the data processing module after the device 
connects to the IDMVS. For details, please refer to the relevant chapter in the user manual 
of the corresponding model. 
 

3.4 ModBus TCP Test Tool 

The ModBus TCP test tool can be used to test whether the ModBus communication between 
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devices is normal. 
● When the device is working in server mode, ModBus Poll software can be used.  
● When the device is working in client mode, ModBus Slave software can be used. 

3.4.1 ModBus Poll 

When the device works in server mode, the ModBus Poll software will works in client mode, 
and enable an automatic connection to the device. 

Steps  

1. Enter connection setup parameters according to actual demands. 

 

Figure 3-4 Set IP Address and Port 

Note 

The server port is set as 502. 
 

2. Read the holding registers of the device via the 03 command, start reading from address 
offset 0, and set an appropriate number of read registers and polling read interval time. 
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Figure 3-5 Set Polling and Reading Holding Register 

3. Alternately write 3 and 5 to the register of offset address 0 in the control area to trigger 
the device to acquire image once, and return the code reading result in the result area. 

 

Figure 3-6 Results 
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3.4.2 ModBus Slave 

When the device is working in client mode, ModBus Slave software can be used. 

Steps  

1. Run ModBus Slave, and wait for device connection. 
2. Set the device’s Server IP and Server Port according to server settings, enabling the 

automatic connection to ModBus Slave. 

 

Figure 3-7 Set Server IP and Port 

3. Set Slave ID as 255, and monitor the holding register area. 
4. Use 03 command to read the holding register area in sequence according to configured 

interval time. 
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Figure 3-8 Set Slave Definition Parameters 

5. Alternately write 3 and 5 to the register in the control area to trigger the device to acquire 
image once, and return the code reading result in the result area. 

 

Figure 3-9 Results 
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3.5 PLC Settings 

This section takes the ModBus TCP settings of Siemens S7 series PLC as an example to 
explain how to set PLC’s ModBus communication. For ModBus devices from other 
manufacturers or different models, refer to this section and its user manual to configure. 

Steps  

1. Run TIA Portal, click Create new project, enter parameters, and click Create. 

 

Figure 3-10 Create New Project 

2. Add the corresponding PLC controller. 
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Figure 3-11 Add PLC 

3. Set the IP address of the PLC controller. 

 

Figure 3-12 Set IP Address 

4. Go to Communication → Others → MODBUS TCP, and add MB_SERVER command. 
5. Create a new MV_ID_REG data block in MB_HOLD_REG pin to store the communication 

data of the holding register, and add variables to the data block. 
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Figure 3-13 MV_ID_REG Data Block 

6. Create a new MV_MB_TCON data block at the CONNECT pin, create a MV_MB_Server 
variable, appoint its data type as TCON_IP_v4, and expand variables to assign values to it. 

 

Figure 3-14 MV_MB_TCON Data Block 

7. Store other pins to the address starting from M10.0. 
8. Compile the project, and download it to the PLC controller. 

3.6 Device Register Definition 

The device only uses holding registers and a holding register is divided into three areas: 
control, status, and result. 

Control 

The control area controls the device to get images from PLC. 
● Control area location: holding registers. (The offset is configurable and the default value 

is 0). 
● Control area size: 1 register (2 bytes). 
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Table 3-1 Control Area Definition 

REG/bit Name Description 

REG0.0 Trigger 
Enable 

The PLC controls the device’s trigger enable function via this bit. 

REG0.1 Trigger When following conditions are met, the PLC sets this bit to 
trigger the device to acquire an image and run the algorithm 
once. 

● Trigger Enable is set. 
● The device is not currently acquiring images and running 

algorithms. 
● Trigger Ready is set. 

REG0.2 Results Ack After the PLC gets the latest results, Result Ack is set. At the 
same time, Results OK and Results NG will be cleared. 

REG0.3-
14 

Reserved Reserved. 

REG0.15 Clear Error Clear error status. 

Status 

The status area feeds back the device’s current status from the device to PLC. 
● Status area location: holding registers (the offset is configurable and the default value is 

1). 
● Status area size: 1 register (2 bytes). 
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Table 3-2 Status Area Definition 

REG1/bit Name Description 

REG1.0 Trigger Ready The device is ready to receive new trigger signals.  

When the Trigger Enable is set and the device is ready to 
receive the next trigger signal, the Trigger Ready is set. 

REG 1.1 Trigger Ack The device has already received the trigger signal. 

REG 1.2 Acquiring The device is acquiring images. 

REG 1.3 Decoding The device is recognizing decodes on images. 

REG 1.4-7 Reserved Reserved. 

REG 1.8 Results OK The device outputs new results successfully. 

When the PLC is set Results Ack, it will be cleared. 

REG 1.9 Results NG The device does not read codes or get outputted results. 

When the PLC is set Results Ack, it will be cleared. 

Note 

You should disable NoRead function when using NG 
signal. 

REG 1.10-14 Reserved Reserved. 

REG 1.15 General Fault A device’s internal fault occurred, and you can clear this 
signal via Clear Error. 

Result 

The result area stores result data from the device to PLC. 
● Result area location: holding registers (the offset is configurable and the default value is 

2). 
● Result size: 4 to 500 registers (100 by default). 
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Table 3-3 Result Area Definition 

REG/word Name Description 

REG2 Result Length It refers to the length of valid data contained in the 
result area. 

REG3… Result Data It refers to the reading result in ASCII code format 
of continuous storage. 

● When result data length is smaller than 
configured result module, the spare bytes will be 
filled with 0. 

● When result data length is greater than 
configured result module, the extra bytes will be 
cut off. 

3.7 Trigger Test 

Communication Sequence Diagram 

The communication sequence diagram of PLC and the device is shown below. 

 

Figure 3-15 Communication Sequence Diagram 

The logic of the above sequence diagram is shown below: 
1. PLC sets Trigger Enable signal REG0.0. After the device is ready, set Trigger Ready signal 

REG1.0. 
2. After detecting the device’s Trigger Ready signal, the PLC sends Trigger signal REG0.1 

and controls the device to read codes. 
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3. The device starts to acquire images and decode images after receiving Trigger signal. 
● If codes are read successfully, set the Results OK signal REG1.8 and put code length and 

contents into the address starting from REG2. 
● If codes are not read successfully, set the Results NG signal REG1.9 and clear the start 

address of REG2. 

Note 

● If codes are not read successfully when NoRead is enabled, Results OK + “NoRead” 
character are fed back. 

● If codes are not read successfully when NoRead is disabled, Results NG signal is fed back. 
 

4. After detecting Results OK/NG, the PLC starts to read code length and data from REG2. 
5. After reading results is finished, set Results Ack signal REG0.2, and notify the device. 
6. After triggering is finished, reset the PLC first (set Results Ack) and then repeat the steps 

from 1 to 5 above for a new round of triggering. 

Note 

If the smart code reader cannot output results after receiving the Trigger signal due to an 
internal error (for example, acquiring images are not enabled after the smart code reader is 
connected to the IDMVS), the General Fault signal REG1.15 will be set at this time. After the 
PLC confirms the cause of the error, set the Clear Error signal REG0.15, and the trigger 
operation can be continued after the error is cleared. 
 

Create Variables 

Create variables in accordance with the device’s register. 

 

Figure 3-16 Create Variables 

Ladder Diagram 

The PLC triggers the device to read codes, and related ladder diagrams are shown below. 
● Send Control and Reading Status 
Write MW100 to the control area of the device, read the status area of the device to MW102, 
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and create variables for each bit of control and status. 

 

Figure 3-17 Send Control and Reading Status 

● Enable Trigger 

 

Figure 3-18 Enable Trigger 

● Trigger Device to Read Codes 
The trigger signal can be generated by adding an edge signal before Trigger Ready 
according to actual demands. For example, when the PLC detects the photoelectric input 
signal, it sends a trigger signal once. The figure below describes that a trigger signal is 
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outputted every second via the internal system clock. 

 

Figure 3-19 Send Trigger Signal 

● Clear Trigger Signal 

 

Figure 3-20 Clear Trigger Signal 

● Get Device Results 
Create a DB data block to store the reading result, add the result array variable as shown 
below. 

 

Figure 3-21 Add Result Array Variable 

When the device feeds back the Results OK or NG signal, it means that the result data has 
been updated, and the PLC reads the result data to the DB data block. 
After the reading is finished, set the Results Ack signal to acknowledge that the device has 
finished reading the result data. 

Note 

If the order of code byte doesn't match the actual order, enable the Result Byte Swap in the 
device configuration. 
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Figure 3-22 Get Device Results 

● Clear Error 

 

Figure 3-23 Clear Error 

View Results 

Through the monitoring and option tab, you can monitor the status of the variables of each 
module of the device and view the result output. You can also add trace records of the 
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variables via the Trace tab to view the control sequence. 

 

Figure 3-24 View Results 

 

Figure 3-25 View Control Sequence 
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Chapter 4 MELSEC/SLMP 

4.1 Introduction 

MELSEC/SLMP refers to communication protocols such as reading or writing of the device 
data of the Q/L series programmable controller CPU by external devices via the C24 or E71 
module. 

Note 

● Melsec/SLMP supports TCP protocol only and does not support UDP protocol. 
● This chapter takes Mitsubishi O series and FX3U series PLCs as an example to explain 

how to communicate with smart code readers via MELSEC/SLMP communication 
protocol, For other devices, refer to the user manual provided by the manufacturer and 
make related settings by reading contents of chapter. 

 

4.2 Hardware Wiring 

The wiring of Mitsubishi PLC and the smart code reader is shown below. 

Mitsubishi Q Series PLC

Industrial Switch

Smart Code Reader

Mitsubishi FX3U Series PLC

 

Figure 4-1 Hardware Wiring 
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4.3 Smart Code Reader Settings 

Before using the smart code reader’s MELSEC/SLMP function to communicate with other 
devices, you need to set the smart code reader first via the IDMVS client software. 
Before you start: 
● Make sure that the PC has installed the IDMVS client software with version of V3.0.0 and 

above. 
● Check the device’s firmware version. Please refer to the relevant instructions in the 

industrial protocol for specific requirements. 
●  

Steps  

1. Double click the device in the device list to connect it to the client software. 
2. Set the device mode as Normal or Work Mode in the live view window. 
3. Select the connected device and go to IO Control in the panel. 
4. Select On for trigger mode and select trigger source according to actual situation. 
● When using industrial protocol to trigger the device, select as the trigger source and click 

Enable Auto-Trigger. 
● When using IO to trigger the device, select Pin* as the trigger source. Pin hardware 

triggering only feeds back the result region (decoding results), other status bits will not 
be returned. 

Note 

When selecting pin hardware triggering as the trigger source,, avoid triggering in the 
industrial protocol control region (set camera control bits), otherwise the device will 
automatically switch to soft trigger mode, making subsequent IO signals unable to trigger 
the device. 
 

5. Go to Communication Control, select MELSEC/SLMP as communication protocol, and 
enable MELSEC/SLMP Enable. 

6. Enter MELSEC Server IP and MELSEC Server Port according to actual demands. 
7. Set MELSEC Frame Type.  
● Regarding Mitsubishi Q series PLC, you should set MELSEC Frame Type as 3E, or 4E. 
● Regarding Mitsubishi FX3U series PLC, you should set MELSEC Frame Type as 1E. 
8. Set MELSEC Control Poll Interval according to actual demands. 

Note 

● The smaller the configured interval is, the more frequently the reading runs and the greater 
network loads are. 

● The control, status, and result modules are located in the D area of the device. The offset 
address and result module size can be configured. 
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Figure 4-2 Set Parameters 

9. Go to Data Processing in the left navigation panel, and set format and contents contained 
in the outputted information. 

Note 

The result output function can also be set by the data processing module after the device 
connects to the IDMVS. For details, please refer to the relevant chapter in the user manual 
of the corresponding model. 
 

4.4 PLC Settings 

This section takes Mitsubishi FX3U series and Q series PLCs as an example to explain how 
to set PLC. For the PLC from other manufacturers or different models, refer to this section 
and its user manual to configure. 

4.4.1 Mitsubishi FX3U Series PLC 

Mitsubishi FX3U series PLC uses an external Ethernet module to realize MELSEC/SLMP 
communication function, and the hardware configuration should be done before use. Use 
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FX3U-ENET-L configuration tool to set IP address of Ethernet module and enable MC 
communication function. 

Ethernet Module Configuration 

Steps  

1. Run FX3U-ENET-L configurator, select Module 0 and click Operational settings. 

 

Figure 4-3 Ethernet Module Settings 

2. Configure operational settings. 
● Communication data code: The device should be set as BIN_1 frame if Binary code is 

selected, and the device should be set as ASCII_1E frame if ASCII code is selected. 
● Initial timing: Select Always wait for OPEN. 
● IP address: It should be the same with the device’s Server IP address. 
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Figure 4-4 Ethernet Operational Settings 

3. Open Ethernet open settings, set TCP as Protocol, Passive (MC) as Open system, and 
5000 as host station Port No. (DEC.). 

4. Write to PLC after configuration. 

Create GX-Works2 Project 

When using Mitsubishi FX3U series PLC, you should also create GX-Works2 project. 

Steps  

1. Create a new GX-Works2 project, set Series and Type in according with FX3U series PLC. 
2. Go to Navigation → Connection Destination → PC Side I/F Serial Setting → Serial 

USB, and set COM Port and Transmission Speed. 

Note 

Make sure that PLC can be visited via the cable of USB to serial port. 
 

4.4.2 Mitsubishi Q Series PLC 

Regarding the Mitsubishi Q series PLC, you can configure it via GX-Works2. 

Steps  

1. Create a new GX-Works2 project, set Series and Type in according with Q series PLC. 
2. Go to Navigation → Connection Destination → PC Side I/F, select Q Series Bus, and 

select Ethernet to test communication connection. 
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Note 

Make sure that the PLC can be visited via the network. 
 

3. Go to Navigation → Project → Parameters → PLC Parameters → Built-in Ethernet 
Port, set the IP address of the PLC that should be the same with the device’s Server IP 
address. 

4. Set communication data code: The device should be set as BIN_3E frame if Binary code 
is selected, and the device should be set as ASCII_1E frame if ASCII code is selected. 

5. Check Enable online change (FTP, MC protocol). 
6. Click Open settings, enable MC protocol, set TCP protocol and port that should be the 

same with the device’s Server port address. 

4.5 Device Module Definition 

The device has three modules, including control, status, and result. 

Control 

The control module controls the device to get images from PLC. 
● Control module location: software component D area (the offset is configurable and the 

default value is 0). 
● Control module size: 2 bytes. 
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Table 4-1 Control Module Definition 

D0/bit Name Description 

D0.0 Trigger 
Enable 

The PLC controls the device’s trigger enable function via this bit. 

D0.1 Trigger When following conditions are met, the PLC sets this bit to trigger 
the device to acquire an image and run the algorithm once. 

● Trigger Enable is set. 
● The device is not currently acquiring images and running 

algorithms. 
● Trigger Ready is set. 

D0.2 Results Ack After the PLC gets the latest results, Result Ack is set. At the same 
time, Results OK and Results NG will be cleared. 

D0.3-14 Reserved Reserved. 

D0.15 Clear Error Clear error status. 

Status 

The status module feeds back the device’s current status from the device to PLC. 
● Status module location: software component D area (the offset is configurable and the 

default value is 1). 
● Status module size: 2 bytes. 
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Table 4-2 Status Module Definition 

D1/bit Name Description 

D1.0 Trigger 
Ready 

The device is ready to receive new trigger signals.  

When the Trigger Enable is set and the device is ready to receive 
the next trigger signal, the Trigger Ready is set. 

D1.1 Trigger Ack The device has already received the trigger signal. 

D1.2 Acquiring The device is acquiring images. 

D1.3 Decoding The device is recognizing decodes on images. 

D1.4-7 Reserved Reserved. 

D1.8 Results OK The device outputs new results successfully. 

When the PLC is set Results Ack, it will be cleared. 

D1.9 Results NG The device does not read codes or get outputted results. 

When the PLC is set Results Ack, it will be cleared. 

Note 

You should disable NoRead function when using NG signal. 

D1.10-14 Reserved Reserved. 

D1.15 General 
Fault 

A device’s internal fault occurred, and you can clear this signal via 
Clear Error. 

Result 

The result module stores result data from the device to PLC. 
● Result module location: software component D area (the offset is configurable and the 

default value is 2). 
● Result size: 2 to 500 words (100 by default). 
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Table 4-3 Result Module Definition 

Word Name Description 

D2 Result 
Length 

It refers to the length of valid data contained in the result area. 

D3… Result Data It refers to the reading result in ASCII code format of continuous 
storage. 
● When result data length is smaller than configured result 

module, the spare bytes will be filled with 0. 
● When result data length is greater than configured result module, 

the extra bytes will be cut off. 

4.6 Trigger Test 

Communication Sequence Diagram 

The communication sequence diagram of PLC and the device is shown below. 

 

Figure 4-5 Communication Sequence Diagram 

The logic of the above sequence diagram is shown below: 
1. PLC sets Trigger Enable signal D0.0. After the device is ready, set Trigger Ready signal 

D1.0. 
2. After detecting the device’s Trigger Ready signal, the PLC sends Trigger signal D0.1 and 

controls the device to read codes. 
3. The device starts to acquire images and decode images after receiving Trigger signal. 
● If codes are read successfully, set the Results OK signal D1.8 and put code length and 
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contents into the address starting from D2. 
● If codes are not read successfully, set the Results NG signal D1.9 and clear the start 

address of D2. 

Note 

● If codes are not read successfully when NoRead is enabled, Results OK + “NoRead” 
character are fed back. 

● If codes are not read successfully when NoRead is disabled, Results NG signal is fed back. 
 

4. After detecting Results OK/NG, the PLC starts to read code length and data from D2. 
5. After reading results is finished, set Results Ack signal D0.2, and notify the device. 
6. After triggering is finished, reset the PLC first (set Results Ack) and then repeat the steps 

from 1 to 5 above for a new round of triggering. 

Note 

If the smart code reader cannot output results after receiving the Trigger signal due to an 
internal error (for example, acquiring images are not enabled after the smart code reader is 
connected to the IDMVS), the General Fault signal D1.15 will be set at this time. After the 
PLC confirms the cause of the error, set the Clear Error signal D0.15, and the trigger 
operation can be continued after the error is cleared. 
 

Ladder Diagram 

The PLC triggers the device to read codes, and related ladder diagrams are shown below. 
● Enable Trigger 

 

Figure 4-6 Enable Trigger 

● Trigger Device to Read Codes 
The trigger signal can be generated by adding an edge signal before Trigger Ready 
according to actual demands. For example, when the PLC detects the photoelectric input 
signal, it sends a trigger signal once. 

 

Figure 4-7 Send Trigger Signal 
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● Clear Trigger Signal 

 

Figure 4-8 Clear Trigger Signal 

● Get Device Results 
When the device feeds back the Results OK or NG signal, it means that the result data has 
been updated, and the PLC reads the result data to the DB data block. 
After the reading is finished, set the Results Ack signal to acknowledge that the device has 
finished reading the result data. 

 

Figure 4-9 Get Device Results 

● Clear Error 
When there is a trigger error and no result outputted, General Fault signal is set. After 
locating the cause of the error, the Clear Error signal can be set to clear the error and the 
device continues to acquire images. 

 

Figure 4-10 Clear Error 

View Results 

You can monitor the status of each module variable of the device and view outputted results 
via the software component/buffered memory. You can also observe the changing 
sequence of module signals of the device via sample tracking. 
  



Smart Code Reader Industrial Protocol Operation Manual 

62 

Chapter 5 FINS 

5.1 Introduction 

FINS (Factory Interface Network Service) communication protocol is a command/response 
system for industrial automation control networks developed by Omron, and it helps achieve 
seamless communication between various networks. 

Note 

This chapter takes Omron NX series PLC as an example to explain how to communicate 
with the smart code reader via the FINS communication protocol. For other devices, refer to 
the user manual provided by the manufacturer and make related settings by reading 
contents of this chapter. 
 

5.2 Hardware Wiring 

The wiring of Omron NX series PLC and the smart code reader is shown below. 

Omron NX Series PLC Industrial Switch

Smart Code Reader

 

Figure 5-1 Hardware Wiring 

5.3 Smart Code Reader Settings 

Before using the smart code reader’s FINS function to communicate with PLC devices, you 
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need to set the smart code reader first via the IDMVS client software. 
Before you start: 
● Make sure that the PC has installed the IDMVS client software with version of V3.0.0 and 

above. 
● Check the device’s firmware version. Please refer to the relevant instructions in the 

industrial protocol for specific requirements. 

Steps  

1. Double click the device in the device list to connect it to the client software. 
2. Set the device mode as Normal or Work Mode in the live view window. 
3. Select the connected device and go to IO Control in the panel. 
4. Select On for trigger mode and select trigger source according to actual situation. 
● When using industrial protocol to trigger the device, select Software as the trigger source 

and click Enable Auto-Trigger. 
● When using IO to trigger the device, select Pin* as the trigger source. Pin hardware 

triggering only feeds back the result region (decoding results), other status bits will not 
be returned. 

Note 

When selecting pin hardware triggering as the trigger source, avoid triggering in the 
industrial protocol control region (set camera control bits), otherwise the device will 
automatically switch to soft trigger mode, making subsequent IO signals unable to trigger 
the device. 
 

5. Go to Communication Control select FINS as communication protocol, and enable Fins 
Enable. 

6. Enter FINS Server IP and FINS Server Port according to actual demands. 
7. Set FINS Control Poll Interval according to actual demands. 

Note 

The control, status, and result modules are located in the DM area of the device. The offset 
address and result module size can be configured. 
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Figure 5-2 Set Parameters 

8. Go to Data Processing in the left navigation panel, and set format and contents contained 
in the outputted information. 

9. Set the content output by FINS communication result via the Result Setting Control 
according to actual needs. 

Note 

The result output function can also be set by the data processing module after the device 
connects to the IDMVS. For details, please refer to the relevant chapter in the user manual 
of the corresponding model. 
 

5.4 PLC Settings 

This section takes Omron NJ102-9000 PLC as an example to explain how to set PLC. For 
the PLC from other manufacturers or different models, refer to this section and its user 

manual to configure. Note 

Only port 2 of Omron NJ102-9000 PLC supports FINS communication. Thus, make sure that 
the port 2 is in the same network segment with the device. At the same time, Sysmac Studio 
configures the PLC via port 1. Thus, make sure that the port 1 is in the same network 
segment with the PC. 
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Steps  

1. Run Sysmac Studio, click New Project, enter parameters, and click Create. 

 

Figure 5-3 Create New Project 

2. Go to Configurations and Setup →  Controller Setup →  Built-in Ethernet/IP Port 
Settings, and set the IP address of PLC port 1 and port 2 via TCP/IP Settings. 

Note 

● The configured IP address of PLC’s port 1 should be in the same network segment with 
the PC. 

● The configured IP address of PLC’s port 2 should be in the same network segment with 
the device’s IP address. 

 

 

Figure 5-4 Set IP Address 

3. Enter FINS/TCP port and configure FINS/TCP connection settings. 
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Figure 5-5 Configure Port and Connection Settings 

4. Create global variables for the FINS communication. 

 

Figure 5-6 Create Global Variables 

5. Enable DM area by checking it, as shown below, and allocate created global variables to 
the DM memory. 

 

Figure 5-7 Enable DM Area 
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6. Save settings, go to Controller → Online, and connect to the PLC. 

7. Go to Controller → Transfer… → Transfer to Control…, and write configuration to PLC. 

5.5 Device Storage Area Definition 

The FINS communication uses DM storage area only that consists of three areas, including 
control, status, and result. 

Control 

The control area controls the device to get images from PLC. 
● Control area location: DM storage area (the offset is configurable and the default value 

is 0). 
● Control area size: 2 bytes. 

Table 5-1 Control Area Definition 

D0/bit Name Description 

D0.0 Trigger 
Enable 

The PLC controls the device’s trigger enable function via this bit. 

D0.1 Trigger When following conditions are met, the PLC sets this bit to trigger 
the device to acquire an image and run the algorithm once. 

● Trigger Enable is set. 
● The device is not currently acquiring images and running 

algorithms. 
● Trigger Ready is set. 

D0.2 Results Ack After the PLC gets the latest results, Result Ack is set. At the same 
time, Results OK and Results NG will be cleared. 

D0.3-14 Reserved Reserved. 

D0.15 Clear Error Clear error status. 

Status 

The status area feeds back the device’s current status from the device to PLC. 
● Status area location: DM storage area (the offset is configurable and the default value is 

1). 
● Status area size: 2 bytes. 
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Table 5-2 Status Area Definition 

D1/bit Name Description 

D1.0 Trigger 
Ready 

The device is ready to receive new trigger signals.  

When the Trigger Enable is set and the device is ready to receive 
the next trigger signal, the Trigger Ready is set. 

D1.1 Trigger Ack The device has already received the trigger signal. 

D1.2 Acquiring The device is acquiring images. 

D1.3 Decoding The device is recognizing decodes on images. 

D1.4-7 Reserved Reserved. 

D1.8 Results OK The device outputs new results successfully. 

When the PLC is set Results Ack, it will be cleared. 

D1.9 Results NG The device does not read codes or get outputted results. 

When the PLC is set Results Ack, it will be cleared. 

Note 

You should disable NoRead function when using NG signal. 

D1.10-14 Reserved Reserved. 

D1.15 General 
Fault 

A device’s internal fault occurred, and you can clear this signal via 
Clear Error. 

Result 

The result area stores result data from the device to PLC. 
● Result area location: DM storage area(the offset is configurable and the default value is 

2). 
● Result area size: 4 to 500 registers (100 by default). 
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Table 5-3 Result Area Definition 

DM/Word Name Description 

D2 Result 
Length 

It refers the length of valid data contained in the result area. 

D3… Result Data It refers t the reading result in ASCII code format of continuous 
storage. 
● When result data length is smaller than configured result 

module, the spare bytes will be filled with 0. 
● When result data length is greater than configured result 

module, the extra bytes will be cut off. 

5.6 Trigger Test 

Communication Sequence Diagram 

The communication sequence diagram of PLC and the device is shown below. 

 

Figure 5-8 Communication Sequence Diagram 

The logic of the above sequence diagram is shown below: 
1. PLC sets Trigger Enable signal D0.0. After the device is ready, set Trigger Ready signal 

D1.0. 
2. After detecting the device’s Trigger Ready signal, the PLC sends Trigger signal D0.1 and 

controls the device to read codes. 
3. The device starts to acquire images and decode images after receiving Trigger signal. 
● If codes are read successfully, set the Results OK signal D1.8 and put code length and 
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contents into the address starting from D2. 
● If codes are not read successfully, set the Results NG signal D1.9 and clear the start 

address of D2. 

Note 

● If codes are not read successfully when NoRead is enabled, Results OK + “NoRead” 
character are fed back. 

● If codes are not read successfully when NoRead is disabled, Results NG signal is fed back. 
 

4. After detecting Results OK/NG, the PLC starts to read code length and data from D2. 
5. After reading results is finished, set Results Ack signal D0.2, and notify the device. 
6. After ending triggering is finished, reset the PLC first (set Results Ack) and then repeat 

the steps from 1 to 5 above for a new round of triggering. 

Note 

If the smart code reader cannot output results after receiving the Trigger signal due to an 
internal error (for example, acquiring images are not enabled after the smart code reader is 
connected to the IDMVS), the General Fault signal D1.15 will be set at this time. After the 
PLC confirms the cause of the error, set the Clear Error signal D0.15, and the trigger 
operation can be continued after the error is cleared. 
 

Create Variables 

Create the variable as shown below according to the device’s storage area definition. 

 

Figure 5-9 Create Variables 

Ladder Diagram 

The PLC triggers the device to read codes, and related ladder diagrams are shown below. 
● Enable Trigger 



Smart Code Reader Industrial Protocol Operation Manual 

71 

 

Figure 5-10 Enable Trigger 

● Trigger Device to Read Codes 
The trigger signal can be generated by adding an edge signal before Trigger Ready 
according to actual demands. For example, when the PLC detects the photoelectric input 
signal, it sends a trigger signal once. 

 

Figure 5-11 Send Trigger Signal 

● Clear Trigger Signal 

 

Figure 5-12 Clear Trigger Signal 

● Get Device Results 
When the device feeds back the Results OK or NG signal, it means that the result data has 
been updated, and the PLC reads the result data to the DB data block. 
After the reading is finished, set the Results Ack signal to acknowledge that the device has 
finished reading the result data. 

Note 

If the endianness of codes read is different from actual one, you can enable result byte swap 
function via the IDMVS. 
 

 

Figure 5-13 Get Device Results 

● Clear Error 
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Figure 5-14 Clear Error 

View Results 

You can monitor the status of each module variable of the device and view outputted results 
via the monitor window. 

 

Figure 5-15 View Results 
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Chapter 6 Revision History 

Table 6-1 Revision History 

Version Document No Revision Date Revision Details 

V1.0.1 UD42937B May 15, 2025 Fix some errors. 

V1.0.0 UD26848B Sep. 9, 2022 Original version. 
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